
Giáo trình Sử dụng hệ điều hành và quản lý máy tính 

 

3 

 

LỜI MỞ ĐẦU 

Chương trình đào tạo "Tin học văn phòng chuyên nghiệp" được Công ty  

Điện toán và truyền số liệu (VDC) xây dựng và phát triển theo các chuẩn quốc tế về 

ứng dụng công nghệ thông tin (CNTT) cho các đối tượng người dùng (end user). 

Chương trình cung cấp kiến thức về các khái niệm của CNTT, các kỹ năng sử dụng 

máy tính cá nhân và các phần mềm ứng dụng chung ở mức từ cơ bản đến nâng cao. 

Tài liệu học tập và giáo trình bằng tiếng Việt, luôn được cập nhật các công nghệ 

mới nhất, được cung cấp miễn phí cho học viên khi đăng ký học trên lớp hoặc đăng 

ký thi học phần. 

Chương trình "Tin học văn phòng chuyên nghiệp" gồm 7 học phần, mỗi 

học phần cung cấp cho học viên một nội dung kiến thức cụ thể, độc lập. Hệ thống 

thi sát hạch hoàn toàn độc lập với quá trình học trên lớp. Khi đăng ký thi sát hạch, 

học viên được phát miễn phí tài liệu học tập, học viên có thể tự học và tham dự kỳ 

thi sát hạch mà không cần phải đến lớp học. Học viên phải thực hiện một bài thi 

thực hành trên máy tính trong vòng 120 phút và một bài thi lý thuyết trực tuyến trên 

mạng trong 60 phút. Điểm đạt yêu cầu là 70/100 điểm cho bài thi thực hành và 

60/100 điểm cho bài thi lý thuyết. Các học phần này gồm: 

1- Các khái niệm cơ bản về CNTT 

2- Sử dụng hệ điều hành và quản lý máy tính  

3- Soạn thảo văn bản (MS Word) 

4- Bảng tính điện tử (MS Excel) 

5- Kỹ năng trình diễn (MS PowerPoint) 

6- Cơ sở dữ liệu (MS Access) 

7- Ứng dụng của mạng LAN và mạng Internet trong công việc 

  Chương trình “Tin học văn phòng chuyên nghiệp” đầu tiên được khai 

giảng vào ngày 15/08/2005, có các lớp học sáng, chiều và tối, tuần học 3 buổi. Các 

học viên sẽ được tư vấn đầy đủ về nội dung học, thời gian học, hình thức thi…Mọi 

chi tiết xin liên hệ: 

 TRUNG TÂM ĐÀO TẠO CÔNG NGHỆ THÔNG TIN  

Toà nhà Fafilm, Tầng 4, số 19 Nguyễn Trãi, Thanh Xuân, Hà Nội  

Tel: (04) 5 680 373 Fax: (04) 5 680 374  Email: itcvdc1@vnn.vn 

http://www.itc.vdc.com.vn 

mailto:itcvdc1@vnn.vn
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Chương 1  

LÀM QUEN VỚI HỆ ĐIỀU HÀNH WINDOWS 

 

Bài 1.1: Giới thiệu Windows XP 

 

Windows là tập hợp các chương trình điều khiển máy tính thực hiện các chức 

năng chính như:  

 - Điều khiển phần cứng của máy tính. Ví dụ: Nó nhận thông tin nhập từ bàn 

phím và gửi thông tin xuất ra màn hình hoặc máy in.  

 - Làm nền cho các chương trình ứng dụng khác chạy. Ví dụ như các chương 

trình xử lý văn bản, hình ảnh, âm thanh…   

- Quản lý việc lưu trữ thông tin trên các ổ đĩa.  

- Cung cấp khả năng kết nối và trao đổi thông tin giữa các máy tính.  

Windows có giao diện đồ họa (GUI – Graphics User Interface). Nó dùng các 

phần tử đồ họa như biểu tượng (Icon), thực đơn (Menu) và hộp thoại (Dialog) chứa 

các lệnh cần thực hiện.   

Windows XP là một phiên bản mới của hệ điều hành Windows, kế thừa từ các 

phiên bản Windows 95, 98, 2000, với nhiều tính năng ưu việt và hiện đang được sử 

dụng phổ biến cho các máy tính cá nhân để bàn. 

Để sử dụng được hệ điều hành Windows, yêu cầu máy tính của bạn phải có cấu 

hình tối thiểu như sau: 

- Bộ xử lý Pentium II 300 MHz 

- RAM 128 MB 

- Bộ nhớ trống 1,5 GHz. 
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Bài 1.2: Khởi động Windows 

 

1. Bật màn hình máy tính 

Ấn vào công tắc nguồn on/off trên màn hình máy tính. Khi đèn báo sáng tức là 

màn hình máy tính đang bật và ngược lại, đèn không sáng tức là màn hình máy tính 

đang tắt. 

2. Bật công tắc nguồn của máy tính 

Bạn chỉ cần bật công tắc (Power), Windows sẽ tự động chạy. Tùy thuộc vào 

cách cài đặt, có thể bạn phải gõ mật mã (Password) để vào màn hình làm việc, gọi 

là Desktop của Windows.  

 
Hình 1.1 

 

Hoặc bạn ấn tổ hợp phím Ctrl + Alt + Delete, khi đó sẽ hiện ra của sổ như hình 

1.2. Để truy nhập vào bạn phải gõ đúng User Name (tên truy nhập), Password (mật 

khẩu) và kích chuột vào OK. Nếu đúng User Name và Password, bạn sẽ truy nhập 

vào màn hình Desktop của Windows. 

 

 
Hình 1.2
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Bài 1.3: Màn hình Windows XP 

 

Sau khi khởI động xong, màn hình của Windows XP thường có dạng như hình 1.3 

 

 
 

Menu Start 

Thanh công cụ  khởi động 

nhanh 

Thanh tác vụ Chương trình hệ thống 

Thùng rác 

Màn hình 

Desktop 
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Hình 1.3 

 

Dưới đây là các thành phần chính trong màn hình Windows: 

 

Thành phần Chức năng 

Màn hình Desktop Đây là màn hình bạn sẽ thấy đầu tiên khi khởi động 

Windows. Có chức năng như mặt bàn làm việc, nơi chứa 

các biểu tượng, các tệp tin (file), thư mục của các chương 

trình ứng dụng theo ý bạn. Bạn có thể thay đổi nền màn 

hình theo ý muốn của mình. 

My Documents My Documents là một thư mục đặc biệt, nơi cho phép bạn 

lưu trữ các tệp và tài liệu do bạn tạo ra 

My Computer My Computer cho phép bạn xem được mọi thứ có trong 

máy tính 

My Network Place Nếu máy tính của bạn được kết nối trong môi trường mạng 

thì sẽ có biểu tượng My Network Place xuất hiện trên màn 

hình Desktop, cho phép bạn nhìn thấy các máy khác trong 

mạng và kết nối đến các máy nhìn thấy trong My Network 

 

Menu Start 

Thanh công cụ  khởi động 

nhanh 

Thanh tác vụ Chương trình hệ thống 

Thùng rác 

Màn hình 

Desktop 
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Place 

Recycle Bin Recycle Bin (Thùng rác) nơi lưu trữ tạm thời tất cả các tệp, 

thư mục bạn đã xoá 

Taskbar Thanh tác vụ chứa cửa sổ thu nhỏ của các chương trình bạn 

đang chạy trong Windows. Ứng dụng này cho phép bạn có 

thể chạy nhiều chương trình, mở nhiều cửa sổ đồng thời, 

muốn chuyển qua chương trình nào bạn kích nào chương 

trình đó trên thanh taskbar. 

Menu Start Menu Start cho phép bạn khởi động bất kỳ chương trình 

nào có trong Windows 

Quick Launch 

Toolbar 

Thanh công cụ khởi động nhanh chứa những chương trình 

cho phép bạn khởi động nhanh với một lần kích chuột thay 

vì phải kích đúp chuột vào biểu tượng đó trên màn hình 

Desktop hoặc mở menu Start. 
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Bài 1.4: Sử dụng Menu Start 

 

Khi kích vào menu Start trên thanh Taskbar, bạn sẽ thấy hiện lên giao diện như 

hình 1.4. 

 

 

Tên của người dùng 

đang sử dụng sẽ xuất 

hiện trên cùng của menu 

Start 

 

Vùng này chứa những biểu 

tượng khởi động các chương 

trình bạn thường xuyên sử 

dụng. 

Chứa toàn bộ chương trình 

được cài đặt trong máy tính 

của bạn. Kích chuột vào All 

Program sẽ hiện ra danh sách 

các chương trình có trong 

máy tính. 

 

Phần bên phải chứa 

các chương trình điều 

khiển hệ thống 

Windows, các thư mục 

quan trọng.  
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Hình 1.4 

 

Dưới đây là các chức năng của các biểu tượng chương trình trong Menu Start: 

 

Biểu tượng Chức năng 

 
Khởi động trình duyệt truy nhập Web; tên mặc định là 

Internet Explorer 

 
Khởi động trình duyệt thư điện tử; tên chương trình là 

Outlook Express 

 

Mở ra danh sách các tài liệu vừa mở ra gần đây nhất 

 
Mở thư mục My Picture, nơi lưu và quản lý các tệp ảnh 

 
Mở thư mục My Music, nơi lưu và quản lý các tệp âm 

thanh 

 
Mở cửa sổ Control Panel, cung cấp các tùy chọn để có thể 

thiết lập và quản lý các giao diện và chức năng của máy 

tính cá nhân theo hệ điều hành cài đặt. 

Tên của người dùng 

đang sử dụng sẽ xuất 

hiện trên cùng của menu 

Start 

 

Vùng này chứa những biểu 

tượng khởi động các chương 

trình bạn thường xuyên sử 

dụng. 

Chứa toàn bộ chương trình 

được cài đặt trong máy tính 

của bạn. Kích chuột vào All 

Program sẽ hiện ra danh sách 

các chương trình có trong 

máy tính. 

 

Phần bên phải chứa 

các chương trình điều 

khiển hệ thống 

Windows, các thư mục 

quan trọng.  



Giáo trình Sử dụng hệ điều hành và quản lý máy tính 

 

16 

 

 
Kết nối đến mạng Internet hoặc mạng nội bộ (LAN) 

 
Hiển thị các máy in, máy fax nếu được cài đặt 

 
Hiển thị các thông tin trợ giúp của Windows XP. 

 
Cho phép bạn tìm kiếm các chương trình, tệp, thư mục. 

 
Mở một chương trình hoặc tệp bằng cách gõ lệnh trực tiếp, 

giống như trong MS-DOS. 

 

Cho phép thoát khỏi hệ thống với account hiện thời và cho 

phép truy nhập vào hệ thống với account khác. 

 
Cung cấp chức năng tắt máy, khởi động lại máy. 
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Bài 1.5: Sử dụng chuột 

 

Chuột dùng điều khiển con trỏ chuột tương tác với những đối tượng trên màn 

hình. Chuột thường có 2 nút:   

- Nút trái thường dùng để chọn đối tượng; di chuyển đối tượng...   

- Nút phải thường dùng hiển thị một thực đơn công việc. Nội dung Thực đơn 

công việc thay đổi tùy thuộc con trỏ chuột đang nằm trên đối tượng nào.  

Các hành động mà chuột thực hiện:  

Trỏ đối 

tượng  

Rê chuột trên mặt phẳng bàn để di chuyển con trỏ chuột trên màn 

hình trỏ đến đối tượng cần xử lý.  

Kích trái    Thường dùng để chọn một đối tượng, bằng cách trỏ đến đối tượng, 

nhấn nhanh và thả nút trái chuột.  

Rê/Kéo 

(Drag)  

Dùng di chuyển đối tượng hoặc quét chọn nhiều đối tượng bằng 

cách trỏ đến đối tượng, nhấn và giữ nút trái chuột, di chuyển chuột 

để dời con trỏ chuột đến vị trí khác, sau đó thả nút trái chuột.  

Kích phải  Thường dùng hiển thị một thực đơn công việc liên quan đến mục 

được chọn, bằng cách trỏ đến đối tượng, nhấn nhanh và thả nút 

phải chuột.  

Kích đúp 

chuột  

(Double 

click)  

Thường dùng để kích hoạt chương trình được hiển thị dưới dạng 

một biểu tượng trên màn hình, bằng cách trỏ đến đối tượng, nhấn 

nhanh và thả nút trái chuột 2 lần.  
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Bài 1.6: Thoát khỏi Windows và tắt máy 

 

Khi đã hoàn thành công việc và không dùng đến máy tính nữa, bạn tắt máy tính 

và rút khỏi nguồn điện. Để Windows hoạt động ổn định và không bị lỗi, trước khi 

tắt máy, bạn phải thoát khỏi Windows (shutdown). Thực hiện Shutdown máy tính 

theo các bước sau: 

1. Lưu các chương trình bạn đang thực hiện và đóng tất cả các cửa sổ chương 

trình còn hiện trên thanh tác vụ. Nếu tắt máy ngang có thể gây ra những lỗi nghiêm 

trọng.  

2. Kích vào menu Start 

3. Kích chọn mục Turn Off Computer.   

- Hộp thoại Turn off computer xuất hiện (Hình 1.5), kíck chuột vào nút Turn 

off. 

- Nếu muốn khởi động lại máy tính, bạn chọn Restart 

- Nếu muốn tạm thời ngưng làm việc với máy tính và để chế độ tiết kiệm điện, 

bạn chọn Stand By   

 

Hình 1.5 
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BÀI TẬP CHƯƠNG 1 

 

1. Bật máy tính và khởi động Windows XP 

2. Tìm, trỏ chuột và kích vào menu Start, sau đó đóng menu Start mà không 

chọn bất kỳ một chương trình nào 

3. Tìm và kích đúp chuột vào My Computer 

4. Shutdown Windows. 
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Chương 2 

LÀM VIỆC VỚI CỬA SỔ WINDOWS 

 

Bài 2.1: Khởi động một chương trình 

Để làm bất kỳ một việc gì trên máy tính, bạn cần phải chạy một chương trình. 

Chương trình là một cấu trúc lệnh được lập trình để ra lệnh cho máy tính thực hiện 

một công việc nào đó. Ví dụ Microsoft Word là một chương trình soạn thảo và xử 

lý văn bản. Cách tốt nhất để khởi động chương trình là kích vào Menu Start, sau đó 

chọn một chương trình cần khởi động trong All Programs. Dưới đây là các bước 

thực hiện khởi động chương trình WordPad trong Windows. 

1. Kích vào menu Start 

2. Trỏ chuột vào All Programs: một thực đơn danh sách các chương trình có 

trong máy tính sẽ xuất hiện như hình 2.1 

 
Hình 2.1 

3. Trỏ chuột vào Accessories: Khi đó hiện ra các chương trình có trong thực 

đơn Accessories. Và bạn sẽ nhìn thấy chương trình cần khởi động WordPad. Đó là 

lý do vì sao phải chọn Accessories. Bạn phải biết chương trình cần khởi động nằm 

ở thực đơn nào và phải trỏ đến đúng thực đơn đó. 



Giáo trình Sử dụng hệ điều hành và quản lý máy tính 

 

21 

 

 
Hình 2.2 

4. Kích chuột vào WordPad: Chương trình WordPad sẽ xuất hiện trên màn 

hình. WordPad là một chương trình soạn thảo văn bản đơn giản được tích hợp sẵn 

trong Windows. 

 

Bất kỳ chương trình 

nào đang chạy sẽ 

xuất hiện trên thanh 

tác vụ Taskbar 
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                                   Hình 2.3 

 

 

 

 

Bài 2.2: Tìm hiểu các thành phần của cửa sổ Windows 

Mọi thứ bạn có thể làm trên máy tính xuất hiện bên trong các khung được gọI 

là cửa sổ. Làm việc với cửa sổ sẽ trở nên dễ dàng khi bạn hiểu được chức năng các 

thành phần cơ bản của chúng.  

Khi bạn mở một chương trình nào đó trong Windows sẽ xuất hiện một cửa sổ 

chương trình đó. Tất cả cửa sổ các chương trình này đều có chung một số giao diện 

và chức năng giống nhau. Hình vẽ dưới đây là cửa sổ chương trình WordPad. 

 

Bất kỳ chương trình 

nào đang chạy sẽ 

xuất hiện trên thanh 

tác vụ Taskbar 

Nút phóng 

to 
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Hình 2.4 

 

Dưới đây là bảng liệt kê các thành phần và chức năng của chúng trong cửa sổ 

Windows. 

 

Thành phần Mô tả 

Thanh tiêu đề (Title bar) Hiển thị tên của cửa sổ chương trình 

Nút thu nhỏ Thực hiện chức năng thu nhỏ cửa sổ hoặc ẩn cửa sổ 

xuống thanh tác vụ của màn hình Windows 

Nút thu nhỏ 

Nút đóng 

Thanh tiêu đề 

Thanh 

thực đơn 

Thanh công 

cụ 

Khu vực cửa 

sổ chính 

Thanh trạng 

thái 

Nút thu nhỏ 

Nút đóng 

Thanh tiêu đề 

Thanh 

thực đơn 

Thanh công 

cụ 

Khu vực cửa 

sổ chính 

Thanh trạng 

thái 
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Nút phóng to Thực hiện chức năng phóng to cửa sổ chương trình 

hoặc kích hoạt chương trình hiển thị lên màn hình 

máy tính khi chương trình đang ẩn dưới thanh taskbar 

Nút đóng Đóng cửa sổ chương trình khi bạn hoàn thành công 

việc, thoát nó khỏi màn hình và bộ nhớ máy tính. 

Thanh thực đơn Chứa các chức năng điều khiển và tiện ích của 

chương trình 

Thanh công cụ Chứa các biểu tượng tiện ích thường dùng của cửa sổ 

chương trình 

Khu vực cửa sổ chính Đây là nơi các thao tác của chương trình được thực 

hiện 

Thanh trạng thái Hiển thị các thông tin trạng thái của chương trình 

đang sử dụng 

 

 

 

  

Bài 2.3: Di chuyển và thay đổi kích thước cửa sổ 

Bạn có thể mở nhiều cửa sổ chương trình trên màn hình cùng một lúc. Để 

chuyển đổi hoặc xem được nhiều cửa sổ chương trình trên màn hình, bạn phải di 

chuyển và thay đổi kích thước của chúng.  

Thao tác di chuyển cửa sổ chương trình thực hiện như sau: 

1. Đặt con trỏ chuột vào vị trí thanh tiêu đề 

2. Kích và giữ trái chuột vào thanh tiêu đề 

3. Giữ và kéo chuột đến vị trí cần để cửa sổ chương trình 

Thao tác thay đổi kích thước cửa sổ chương trình: 

1. Màn hình đang hiển thị cửa sổ chương trình cần thay đổi kích thước và 

không được hiển thị ở chế độ phóng to nhất.  

2. Đặt chuột vào đường ranh giới của cửa sổ chương trình sao cho con chuột 

xuất hiện thành hình  
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3. Kích trái chuột và kéo để thay đổi kích thước cửa sổ chương trình. 

 
Hình 2.5 

Thao tác chuyển đổi giữa các cửa sổ chương trình: 

 Để chuyển đổi giữa các chương trình đang chạy trên máy tính, bạn có thể thực 

hiện theo một trong các cách sau: 

Cách 1: Kích chuột vào chương trình cần chuyển đổi trên thanh Taskbar 

Cách 2: Ấn tổ hợp phím Alt + Tab cho đến khi chọn được chương trình cần 

chuyển đổi. 
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BÀI TẬP CHƯƠNG 2 

 

1. Mở chương trình WordPad trong thực đơn Start → Accessories 

2. Phóng to, thu nhỏ chương trình WordPad 

3. Mở chương trình máy tính Calculator 

4. Hiển thị hai chương trình đồng thời trên màn hình máy tính. 

5. Đóng hai chương trình trên, đưa trở về màn hình Desktop. 
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Chương 3 

QUẢN LÝ TỆP (FILE) VÀ THƯ MỤC (FOLDER) 

 

Mục tiêu của chương này: 

- Hiểu các thiết bị lưu trữ, các khái niệm tệp (file) và thư mục (folder) 

- Sử dụng My Computer để xác định vị trí của tệp và thư mục trong máy tính 

- Mở, tạo mới và đổi tên tệp và thư mục 

- Sao chép, xóa, di chuyển tệp và thư mục 

- Khôi phục những tệp và thư mục đã xóa 

- Thay đổi những thông tin hiển thị của tệp và thư mục 

- Chọn nhiều tệp và thư mục cùng một lúc 

- Tìm tệp và thư mục sử dụng chức năng tìm kiếm Search 

- Sử dụng công cụ Windows Explore 

 

Bài 3.1: Khái niệm cơ bản về tệp (file), thư mục (folder) và thiết bị lưu trữ 

 

Để quản lý được tệp và thư mục trong máy tính, trước hết bạn phải hiểu máy 

tính lưu trữ thông tin như thế nào. Máy tính lưu trữ thông tin trong các tệp, các tệp 

được chứa trong thư mục và các thư mục được lưu trong các ổ đĩa. Có bốn loại ổ đĩa 

máy tính dùng để lưu trữ thông tin. Chi tiết được mô tả trong bảng dưới đây: 

 

Loại ổ 

đĩa 

Ký hiệu Dung lượng Mô tả 

 

Ổ đĩa 

ổ A hoặc ổ 

B 

1.44 MB Ổ mềm cho phép đọc và ghi thông tin 

lên đĩa mềm. Đĩa mềm không lưu được 

nhiều thông tin, thường dùng để lưu các 

tệp có dung lượng nhỏ (dưới 1,44 MB) 



Giáo trình Sử dụng hệ điều hành và quản lý máy tính 

 

28 

 

mềm di chuyển từ máy tính này sang máy tính 

khác. 

 

Ổ cứng 

ổ C hoặc 

lần lượt D, 

E tuỳ theo 

số lượng ổ 

cứng 

Tuỳ theo 

dung lượng ổ 

cứng máy 

tính, thường 

từ 4 GB trở 

lên 

Ổ cứng lưu tất cả các thông tin quan 

trọng của máy tính. Cho phép đọc và ghi 

dữ liệu. 

 

Ổ CD 

Rom 

Ổ D hoặc 

E, tuỳ theo 

thứ tự ổ 

cứng 

600 MB Ổ CD Rom dùng để đọc các đĩa CD. Ổ 

CD Rom thường dùng để cài đặt các 

chương trình phần mềm, chỉ cho phép 

đọc, không được phép ghi 

 

Ổ USB 

Ổ E hoặc 

G, tuỳ theo 

thứ tự các 

ổ trên 

Linh hoạt từ 

32 MB đến 

512 MB trở 

lên 

Ổ USB có thể di chuyển, mang các đặc 

điểm của ổ mềm và ổ CD Rom nên rất 

tiện dụng trong việc sử dụng và lưu trữ 

thông tin cần di chưyển giữa các máy 

tính. 

 

 

 

 

Bài 3.2: Xem thông tin về ổ đĩa 

Khi muốn xem toàn bộ các ổ đĩa trong máy tính và các thông tin về ổ đĩa, bạn 

thực hiện theo các bước sau: 

1. Kích chuột vào menu Start, chọn biểu tượng My computer 

- Cửa sổ My Computer sẽ xuất hiện như 3.1 và bạn sẽ thấy hiển thị tất cả các 

thiết bị ổ đĩa đang có trong máy tính. 
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Hình 3.1 

 

2. Kích đúp chuột vào biểu tượng ổ C để xem nội dung bên trong ổ C: Bạn sẽ 

thấy xuất hiện các thư mục và các tệp có chứa trong ổ C 

 

 

Các thư mục 

Các tệp 
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Hình 3.2 

 

3. Kích phải chuột vào ổ C rồi chọn Properties để xem các thông số của ổ C 

- Cửa sổ Properties của ổ C xuất hiện như hình 3.3. Cửa sổ này sẽ cung cấp 

cho bạn các thông tin về dung lượng ổ đĩa, dung lượng đã dùng và dung lượng còn 

trống. 

 

 

Các thư mục 

Các tệp 

Dung lượng ổ 

đĩa đã dùng 

Dung lượng ổ 

đĩa còn trống 

Tổng dung 

lượng ổ đĩa 
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Hình 3.3 

 

 

Bài 3.3: Quản lý thư mục 

Thư mục là nơi lưu trữ dữ liệu trong máy tính. Dữ liệu lưu trữ trong thư mục 

bao gồm các thư mục con và các tệp.   

Windows tạo ra một thư mục dành riêng cao nhất để lưu trữ các thư mục và các 

tệp bạn tạo ra, đó là thư mục My Documents. Tuy nhiên, bạn có thể tạo ra các thư 

mục cá nhân của mình trong ổ cứng máy tính. Bài này sẽ hướng dẫn các thao tác 

quản lý, sắp xếp thư mục trong máy tính.  

 

1. Mở một thư mục 

Để mở một thư mục, bạn phải biết thư mục định mở tên là gì và nằm ở đâu hay 

nói cách khác là có đường dẫn như thế nào. 

Ví dụ dưới đây thao tác mở thư mục My Picture nằm trong thư mục My 

Documents. 

Kích vào menu Start, chọn thư mục My Documents: nội dung thư mục 

Dung lượng ổ 

đĩa đã dùng 

Dung lượng ổ 

đĩa còn trống 

Tổng dung 

lượng ổ đĩa 
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 My Documents sẽ mở ra, trong đó bạn thấy bao gồm các tệp, thư mục con, và có 

cả thư mục My Picture bạn cần mở. 

 

Hình 3.4 

Kích đúp chuột vào thư mục My Picture: Nội dung thư mục My Picture sẽ mở 

ra hình 3.5 

 

Thanh 

địa chỉ 

xuất hiện 

tên ổ đĩa 

và đường 

dẫn đến 

thư mục 

hiện tại 
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Hình 3.5 

Thanh địa chỉ tren các cửa sổ Windows cho phép bạn biết được mình đang truy 

nhập vào ổ đĩa và thư mục nào trong máy tính, bạn chỉ cần kích chuột vào mũi tên 

 trên thanh địa chỉ và chọn thư mục cần chuyển đến. 

2. Tạo mới một thư mục 

Mục đích của việc tạo mới một thư mục là bạn tạo ra một thư mục trống ở tại 

một vị trí nào đó trong ổ nhớ máy tính và đặt tên thư mục theo mục đích tạo ra 

nhằm chứa các tệp hoặc thư mục có một điểm chung. 

Thao tác thực hiện như sau: 

- Mở ổ đĩa hoặc thư mục sẽ chứa thư mục bạn định tạo. Ví dụ, bạn định tạo một 

thư mục cá nhân trong ổ D. Bạn phải mở ổ D. 

- Khi cửa sổ đang mở với thanh tiêu đề là ổ D, bạn chọn thực đơn File, chọn 

New → New Folder (Hình 3.6) 

 

Thanh 

địa chỉ 

xuất hiện 

tên ổ đĩa 

và đường 

dẫn đến 

thư mục 

hiện tại 
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Hình 3.6  

 

Khi đó, trong ổ D sẽ xuất hiện một thư mục trống với tên mặc định là New 

Folder, bạn kích chuột vào và gõ tên mới cho thư mục vừa tạo. 

 

 

Kích 

chuột vào 

đây và gõ 

tên mới 

cho thư 

mục vừa 

tạo. 
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Hình 3.7 

 

3. Đổi tên thư mục 

Muốn thay đổi tên thư mục đã đặt, bạn thực hiện như sau: 

Chọn thư mục cần đổi tên: bạn phải đang đứng tại thư mục chứa thư mục cần 

đổi tên. Ví dụ như hình vẽ 3.8, bạn muốn đổi tên thư mục temp folder thành thư 

mục thamkhao trong ổ D. Muốn vậy, trước hết, bạn phải mở ổ D, sau đó chọn thư 

mục temp folder bằng cách kích trái chuột vào temp folder. 

Vào thực đơn File → Rename, hoặc kích phải chuột và chọn Rename. Sau đó 

xóa tên cũ dùng phím Backspace và gõ tên mới cần thay đổi.   

 

Kích 

chuột vào 

đây và gõ 

tên mới 

cho thư 

mục vừa 

tạo. 
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Hình 3.8 

4. Sao chép, di chuyển thư mục 

Sao chép thư mục (copy) là thao tác cần thực hiện khi bạn muốn có một thư 

mục bản sao giống với thư mục nguồn cả về nội dung và tên thư mục nhưng ở 

những vị trí khác nhau. Ví dụ như sao chép thư mục thamkhao từ ổ D: sang ổ A: 

Di chuyển thư mục (cut) là thao tác cần thực hiện khi bạn muốn di chuyển toàn 

bộ một thư mục từ vị trí này đến vị trí khác. 

Để thực hiện hai thao tác trên, bạn làm như sau: 

- Mở ổ đĩa hoặc thư mục có chứa thư mục cần sao chép hoặc di chuyển (gọi là 

thư mục gốc). Ví dụ, bạn muốn sao chép hoặc di chuyển thư mục thamkhao ở ổ D 

sang ổ A, bạn phải mở ổ D bằng cách chọn My computer → Local Disk D: 

- Chọn thư mục cần sao chép hoặc di chuyển bằng cách kích trái chuột. Ở ví dụ 

trên là kích chuột vào thư mục thamkhao.  
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Hình 3.9 

- Vào thực đơn Edit → Copy hoặc kích phải chuột chọn Copy nếu bạn muốn 

sao chép thư mục. (Hình 3.10a) 

- Vào thực đơn Edit → Cut hoặc kích phải chuột chọn Cut nếu bạn muốn di 

chuyển thư mục. (Hình 3.10b) 

 

 

 

 

 

 

 

 

Hình 3.10a 

 

 
Hình 3.10b 
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Mở ổ đĩa hoặc thư mục sẽ chứa thư mục bạn muốn sao chép hoặc di chuyển 

đến (gọi là thư mục đích). Ở ví dụ trên, bạn muốn sao chép hoặc di chuyển đến ổ A 

thì bạn phải có đĩa mềm trong ổ A và mở cửa sổ ổ A bằng cách kích chuột vào 

menu Start → My computer và kích đúp vào ổ A. 

Tại cửa sổ của ổ đĩa hoặc thư mục đích, chọn thực đơn Edit → Paste hoặc kích 

phải chuột chọn Paste. Thao tác này sẽ thực hiện việc sao chép hoặc di chuyển thư 

mục tuỳ theo lệnh ban đầu của bạn là Copy hay Cut. 

 
Hình 3.11 

Kết quả là tại ổ A, bạn sẽ thấy xuất hiện thư mục thamkhao, đồng thời ở ổ D 

cũng vẫn có thư mục thamkhao nếu bạn chọn lệnh sao chép (Copy). 

Hoặc bạn sẽ thấy thư mục thamkhao xuất hiện ở ổ A, nhưng trong ổ D sẽ 

không còn thư mục thamkhao nếu bạn chọn lệnh di chuyển (Cut). 

 
Hình 3.12 
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5. Xóa thư mục 

Khi không dùng đến thư mục nào nữa, bạn có thể xoá thư mục đó đi để tiết 

kiệm ổ nhớ đồng thời hệ thống dữ liệu của bạn cũng rõ ràng và sáng sủa hơn. 

Để thực hiện việc xoá thư mục, bạn thực hiện như sau: 

- Chọn thư mục cần xoá: bạn phải mở ổ đĩa hoặc thư mục chứa thư mục cần 

xoá, sau đó kích chuột trái vào thư mục cần xoá. 

- Vào thực đơn File → Delete hoặc kích phải chuột và chọn Delete. 

 
Hình 3.13 

Hộp thoại Confirm Folder Delete xuất hiện, hỏi bạn có thực sự muốn xóa thư 

mục này không, nếu bạn muốn xoá thì kích chọn Yes, nếu không thì chọn No.  

 
Hình 3.14 

 

6. Thiết lập các tùy chọn cho thư mục 



Giáo trình Sử dụng hệ điều hành và quản lý máy tính 

 

40 

 

Ngoài các thao tác với thư mục như trên, Windows còn cho phép thiết lập một 

số tuỳ chọn đối với thư mục nhằm tiện dụng trong việc quản lý và sử dụng thư mục 

cho người dùng. 

Để thiết lập các tuỳ chọn cho thư mục, bạn thực hiện như sau: 

- Mở một thư mục bất kỳ trong máy tính 

- Vào thực đơn Tool→ Folder Options. Cửa sổ Folder Options xuất hiện như 

hình 3.15 

 
Hình 3.15 

- Bạn thiết lập tính năng nào thì kích trái chuột vào tính năng đó. 

 

Bảng dưới đây mô tả chi tiết các tính năng tuỳ chọn trong cửa sổ Folder 

Options 

 

Các tuỳ chọn Mô tả 

Tasks 

+ Show command tasks in folders Hiển thị các lệnh thao tác đối với thư mục 

và các liên kết mở đến các thư mục khác ở 
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khung bên trái của cửa sổ thư mục 

+ Use Windows class folders Không hiển thị các lệnh thao tác đối với 

thư mục và các liên kết mở đến các thư 

mục khác ở khung bên trái của cửa sổ thư 

mục 

Browser folders 

+ Open each folder in the same window Mở mỗi thư mục trong cùng một cửa sổ.  

+ Open each folder in its own window Mở mỗi thư mục trong một cửa sổ riêng. 

Click items as folow 

+ Single-click to open an item (point to 

select) 

Chỉ cần kích trái chuột vào biểu tượng 

chương trình là có thể mở được chương 

trình đó. 

+ Double-click to open an item (single-

click to select) 

Kích đúp chuột vào biểu tượng chương 

trình để mở chương trình đó. 

 

7. Thay đổi các biểu tượng khác nhau cho thư mục 

Theo mặc định, biểu tượng của thư mục trong Windows là . Tuy nhiên 

bạn có thể thay đổi biểu tượng này thành các hình vẽ khác tùy theo sở thích của 

mình. Cách thực hiện như sau: 

- Kích phải chuột vào thư mục cần thay đổi biểu tượng, chọn Properties 

- Cửa sổ Properties sẽ xuất hiện như hình 3.16, chọn thẻ Customize. 

 
Hình 3.16 
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- Kích chuột vào nút Change Icon, cửa sổ Change Icon xuất hiện. 

- Kích chuột vào một biểu tượng mới trong danh sách các biểu tượng và chọn 

nút OK để hoàn thành. 

 
Hình 3.17 

 

 

Bài 3.4: Quản lý tệp 

Tệp là phần lưu trữ thông tin cuối cùng và nhỏ nhất trong hệ thống lưu trữ dữ 

liệu của máy tính. Mỗi một chương trình ứng dụng lại có một kiểu tệp khác nhau. 

Để mở được bất kỳ một kiểu tệp nào thì máy tính của bạn cài đặt chương trình ứng 

dụng đó. Ví dụ các tệp có kiểu .doc; .exl; .ppt là các kiểu tệp thuộc chương trình 

Microsoft Office, đó là tệp của các chương trình Word, Excel, PowerPoint. Muốn 

mở được các kiểu tệp này thì máy tính của bạn phải cài đặt chương trình Microsoft 

Office. 

Các tệp được chứa trong các thư mục hoặc ổ đĩa. Việc quản lý tệp cũng giống 

như quản lý thư mục. Các thao tác mở, sao chép, di chuyển tệp cũng giống như với 

thư mục. 

1. Mở tệp 
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Để mở một tệp lưu trong ổ đĩa, bạn phải biết đích xác đường dẫn đến tệp đó, 

nghĩa là bạn phải biết tệp đó nằm ở ổ đĩa nào, thư mục nào hoặc thư mục con nào. 

Ví dụ để mở tệp baitap1.doc có đường dẫn là D:\thuchanh\btword. Khi đó, bạn phải 

thực hiện các thao tác sau: 

- Vào thực đơn Start → My computer 

- Kích đúp chuột vào ổ D: để mở ổ D 

- Kích đúp chuột vào thư mục thuchanh để mở thư mục thuchanh 

- Kích đúp chuột vào thư mục btword để mở thư mục btword 

Khi đó bạn sẽ nhìn thấy tệp cần mở, kích đúp chuột vào tệp baitap1.doc để mở 

tệp. Vì kiểu tệp là .doc nên chương trình Word sẽ tự khởi động và bạn sẽ đọc được 

nội dung của tệp này. 

  

 

 

Hình 3.18 

 

Đường dẫn của file trên 

thanh địa chỉ 

Kích đúp chuột vào tên 

file cần mở 

Đường dẫn của file trên 

thanh địa chỉ 

Kích đúp chuột vào tên 

file cần mở 
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2. Đổi tên tệp 

Tên tệp đã được đặt trong lúc bạn tạo và lưu tệp đó lần đầu. Để đổi tên tệp bạn 

thực hiện như sau: 

- Kích phải chuột vào tệp cần đổi tên, chọn Rename 

- Xoá tên tệp cũ và gõ vào tên tệp mới và ấn Enter để hoàn thành (hình 3.19). 

 
                                                       Hình 3.19 

 

3. Xóa tệp 

Khi không sử dụng một tệp bất kỳ nào nữa, bạn nên xoá tệp đó khỏi máy tính 

để tiết kiệm ổ nhớ. Cách thực hiện như sau: 

- Kích phải chuột vào tệp cần xoá, chọn Delete 

- Hộp thoại Confirm File Delete xuất hiện như hình 3.20, hỏi bạn có thực sự 

muốn xoá tệp này không, nếu bạn muốn xoá thì kích chọn Yes, nếu không thì chọn 

No.  
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Hình 3.20 

 

4. Sao chép (copy) và di chuyển (cut) tệp 

Để thực hiện hai thao tác trên, bạn làm như sau: 

- Mở ổ đĩa hoặc thư mục có chứa tệp cần sao chép hoặc di chuyển (gọi là thư 

mục nguồn). Ví dụ, bạn muốn sao chép hoặc di chuyển tệp baitap1.doc ở đường dẫn 

D:\thuchanh\btword sang ổ A, bạn phải mở đúng đến thư mục btword theo đường 

dẫn D:\thuchanh\btword.  

- Chọn tệp cần sao chép hoặc di chuyển bằng cách kích trái chuột. Ở ví dụ trên 

là kích chuột vào tệp baitap1.doc 

- Chọn thực đơn Edit → Copy hoặc kích phải chuột chọn Copy nếu bạn muốn 

sao chép tệp 

Chọn thực đơn Edit → Cut hoặc kích phải chuột chọn Cut nếu bạn muốn di 

chuyển tệp 

 

 

 

Hình 3.21 
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- Mở ổ đĩa hoặc thư mục sẽ chứa tệp bạn muốn sao chép hoặc di chuyển đến 

(gọi là thư mục đích). Ở ví dụ trên, bạn muốn sao chép hoặc di chuyển đến ổ A thì 

bạn phải có đĩa mềm trong ổ A và mở cửa sổ ổ A bằng cách kích chuột vào thực 

đơn Start → My computer và kích đúp vào ổ A. 

- Tại cửa sổ của ổ đĩa hoặc thư mục đích, cụ thể ở đây là ổ A, chọn thực đơn 

Edit → Paste hoặc kích phải chuột chọn Paste. Thao tác này sẽ thực hiện việc sao 

chép hoặc di chuyển thư mục tuỳ theo lệnh ban đầu của bạn là Copy hay Cut. 

(hình3.22) 

 

Hình 3.22 

Kết quả là tại ổ A, bạn sẽ thấy xuất hiện tệp baitap1.doc, đồng thời ở thư mục 

btword cũng vẫn có tệp baitap1.doc nếu bạn chọn lệnh sao chép (Copy). 

Hoặc bạn sẽ thấy tệp baitap1.doc xuất hiện ở ổ A, nhưng trong thư mục 

btword sẽ không còn tệp baitap1.doc nếu bạn chọn lệnh di chuyển (Cut). 
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Hình 3.23 

 

Bài 3.5: Khôi phục lại tệp và thư mục đã xóa 

Giống như thùng rác, Recycle Bin lưu tạm thời tất cả các tệp và thư mục đã 

xoá. Sau một thời gian, những tệp và thư mục chứa trong Recycle Bin sẽ tự động bị 

xoá khỏi Recycle Bin.  

 

1. Khôi phục lại thư mục và tệp mới xoá  

Nếu bạn muốn khôi phục lại những tệp và thư mục đã xoá và vẫn còn chứa 

trong Recycle Bin, bạn có thể thực hiện theo các bước sau: 

- Kích đúp chuột vào biểu tượng Recycle Bin trên màn hình Desktop: Cửa sổ 

Recycle Bin sẽ xuất hiện và hiển thị những tệp và thư mục mà bạn vừa xóa gần đây. 

- Chọn tệp và thư mục trong Recycle Bin cần khôi phục lại 

- Mở phải chuột và chọn Restore. Khi đó những tệp và thư mục được chọn sẽ 

trở về đúng vị trí thư mục mà bạn đã xóa. 
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Hình 3.24 

2. Làm sạch Recycle Bin 

Một trong những mục đích của việc xoá tệp và thư mục không dùng đến là để 

tiết kiệm bộ nhớ. Khi bạn ra lệnh xoá tệp hoặc thư mục, chúng sẽ tạm thời được lưu 

Chọn file cần 

khôi phục và 

mở phải 

chuột 

Chọn file cần 

khôi phục và 

mở phải 

chuột 
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vào Recycle Bin. Khi đó bộ nhớ vẫn phải tốn dung lượng cho việc lưu trữ các tệp 

và thư mục này. Khi biết chắc những tệp và thư mục này chắc chắn xóa, không cần 

khôi phục lại, để tiết kiệm bộ nhớ cho công việc khác, bạn cần làm sạch thùng rác 

ngay. Cách thực hiện như sau: 

- Kích phải chuột vào biểu tượng Recycle Bin trên màn hình Desktop, chọn 

Empty Recycle Bin (hình 3.25) 

 
Hình 3.25 

- Xuất hiện hộp thoại Confirm File Delete, nếu bạn chắc chắn muốn xoá thì 

kích vào Yes. Khi đó Recycle Bin sẽ trống.   

 
Hình 3.26 

 

 

 

Bài 3.6: Các kiểu hiển thị của tệp và thư mục trong cửa sổ Windows 

Khi mở một thư mục trong máy tính sẽ hiện lên danh sách các tệp và thư mục 

chứa trong đó. Windows cung cấp một số cách hiện thị các tệp và thư mục như 

Thumbnails, Icons, Tiles, List, Details,..Tùy theo mục đích sử dụng, bạn có thể 

chuyển đổi giữa các kiểu hiển thị khác nhau. 

Để chuyển đổi giữa các kiểu hiển thị, thực hiện theo các bước sau: 

- Mở một thư mục bất kỳ trong máy tính. 

- Chọn thực đơn View, kích chọn vào một trong các chế độ hiển thị theo bảng 

mô tả ở hình 3.27. 
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Hình 3.27 

Bảng mô tả các chế độ hiển thị trong Windows XP 

Chế độ hiển thị Mô tả 

Icons  

 

Tất cả các tệp và thư mục hiển thị với các biểu tượng. 

Chế độ hiển thị này thuận tiện những ai mới sử dụng 

Windows và còn khó khăn trong thao tác với chuột. 

Nhưng lại không hiển thị tên tệp đầy đủ với những 

tên tệp và thư mục quá dài. 

Tiles 

 

Các tệp và thư mục hiển thị với các biểu tượng và tên 

đầy đủ của tệp và thư mục đó. 

List 

 

Các tệp và thư mục hiển thị theo danh sách từ trên 

xuống kèm theo biểu tượng nhỏ. Chế độ hiển thị này 

thường dùng vì dễ dàng nhìn thấy các tệp và thư mục 

cần mở. 

Details 

 

Hiển thị đầy đủ các thông tin về tệp và thư mục theo 

các cột như tên, kích thước, kiểu và ngày tháng tác 

động lần cuối. Khi kích vào cột nào sẽ cho phép sắp 

xếp theo thứ tự tăng dần hoặc giảm dần theo đặc 

điểm của cột đó. 

Thumbnails 

 

 

Kiểu Thumbnails rất tiện ích khi bạn làm việc với các 

các kiểu tệp và thư mục chứa hình ảnh, đồ hoạ bởi nó 

sẽ hiển thị nội dung tệp ảnh thu nhỏ thay vì phải mở 

hẳn tệp ảnh đó ra. 
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Bài  3.7: Ẩn hiện tệp và thư mục 

Trong quá trình làm việc với tệp và thư mục, có những tệp và thư mục quan 

trọng, bạn muốn lưu giữ chúng và không muốn chúng hiển thị trên cửa sổ thư mục 

để tránh các tác động nhầm lẫn. Windows cho phép bạn ẩn chúng đi và hiển thị 

chúng khi cần. Để thực hiện tính năng trên, bạn làm theo các bước sau: 

Bước 1: Thiết lập tính năng ẩn cho tệp và thư mục: 

- Kích phải chuột vào tệp hoặc thư mục cần ẩn, chọn Properties. 

- Cửa sổ Properties xuất hiện như trên hình 3.28, trong thẻ General, tại mục 

Attributes, bạn kích chuột vào phần Hidden. Muốn bỏ tính năng này thì làm như 

trên và bỏ dấu tích khỏi phần Hidden. 

- Kích chuột vào OK để hoàn thành. 

 

Hình 3.28 

Bước 2: Ẩn hoặc hiển thị tệp và thư mục có tính năng ẩn 

- Mở cửa sổ thư mục bất kỳ. 

- Chọn thực đơn Tool →Folder options. 

- Cửa sổ Forder Options xuất hiện như hình 3.29, chọn thẻ View. 
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- Kích chuột vào dòng chữ Do not show hidden files and folders để ẩn các tệp 

và thư mục đã thiết lập tính năng ẩn. 

- Hoặc kích chuột vào dòng chữ Show hidden files and folders để hiển thị các 

tệp và thư mục đã thiết lập tính năng ẩn. 

- Kích chuột OK để hoàn thành. 

 

Hình 3.29 

 

Bài 3.8: Chọn nhiều tệp và thư mục cùng một lúc 

Muốn thực hiện bất kỳ một thao tác nào cho các tệp hoặc thư mục, trước hết 

bạn phải chọn tệp hoặc một thư mục định cần tác động. Thông thường, bạn chỉ chọn 

một tệp hoặc thư mục bằng cách kích trái chuột vào tệp và thư mục cần chọn. Trong 

nhiều trường hợp, bạn muốn thực hiện cùng một lệnh cho nhiều tệp và thư mục. 

Nếu cứ phải lặp đi lặp lại một lệnh cho ngần ấy tệp hoặc thư mục sẽ rất mất thời 

gian. Windows cho phép bạn thực hiện một lệnh cho nhiều tệp và thư mục cùng một 
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lúc. Để làm được đó, bạn phải chọn nhiều tệp và thư mục cùng một lúc trước khi ra 

một lệnh thực hiện nào đó. Cách chọn nhiều tệp và thư mục thực hiện như sau: 

1. Chọn nhiều tệp và thư mục trong một khoảng liền nhau 

- Đặt chuột vào một khoảng trống trong cửa sổ Windows 

 

 

 

Hình 3.30 

- Giữ trái chuột và kéo tạo nên một hình chữ nhật bao quanh những tệp và thư 

mục bạn muốn chọn. 

Đặt chuột vào đây 

Đặt chuột vào đây 
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Hình 3.31 

2. Chọn nhiều tệp hoặc thư mục liên tiếp cạnh nhau 

- Kích trái chuột vào tệp hoặc thư mục đầu tiên trong danh sách chọn. 

- Ấn và giữ phím Shift 

- Kích trái chuột vào tệp hoặc thư mục cuối cùng trong danh sách chọn. 

 
Hình 3.30 

3. Chọn một số tệp ở những vị trí khác nhau trong cùng một cửa sổ 

- Kích trái chuột vào một tệp hoặc thư mục cần chọn. 

- Ấn và giữ phím Ctrl 

- Kích trái chuột vào những tệp và thư mục cần chọn khác. 
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Hình 3.31 

4. Chọn toàn bộ các tệp và thư mục trong một cửa sổ thư mục 

- Mở thư mục chứa các tệp và thư mục cần chọn 

- Vào thực đơn Edit → Select all. Khi đó toàn bộ các tệp và thư mục trong cửa 

sổ thư mục đó sẽ được chọn.  

 

 

Bài 3.9: Tìm kiếm tệp sử dụng công cụ Search của Windows 

Khi làm việc với nhiều dữ liệu lưu trong máy tính, nhiều khi bạn không nhớ vị 

trí của tệp cần tìm. Sẽ rất mất thời gian nếu bạn dò tìm từng ổ đĩa, thư mục trong 

máy tính. Windows cung cấp một công cụ cho phép nhanh chóng và dễ dàng chỉ ra 

tệp cần tìm nếu bạn biết được một số thông tin như: 

- Tên tệp hoặc một phần tên tệp 

- Ngày tháng tệp được tạo hoặc chỉnh sửa 

- Kiểu tệp 

- Kích thước tệp 

Các thông tin bạn khai báo để tìm kiếm càng chính xác thì bạn càng nhanh 

chóng tìm ra tệp mình cần. 

Cách tìm kiếm tệp sử dụng công cụ Search như sau: 

- Kích chuột vào menu Start, chọn Search, chọn tiếp For Files or Folder 
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Hình 3.32 

 

Khi đó cửa sổ Search Results sẽ xuất hiện như hình 3.33 cho phép bạn khai 

báo các thông số tìm kiếm. 
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Hình 3.33 

Có bốn mục cho bạn lựa chọn tùy theo mục đích tìm kiếm 

+ Nếu bạn kích chuột vào mục Pictures, music, or video, cho phép tìm kiếm 

các tệp ảnh, âm thanh và đoạn phim. Thực hiện theo 3 bước dưới đây: 

 

1. Kích chuột vào một trong 3 

ô trống để lựa chọn kiểu file 

tuỳ theo mục đích tìm kiếm 

2. Gõ tên file hoặc một phần 

tên file cần tìm kiếm vào đây. 

3. Kích vào Search để bắt đầu 

tìm kiếm. 
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Hình 3.34 

+ Nếu bạn kích chuột vào mục Documents (Word processing, spreadsheet, 

etc,..), cho phép bạn tìm kiếm nhanh các tệp tài liệu thuộc bộ Microsoft Office. 

Thực hiện theo 3 bước như hình 3.35. 

 

 

1. Kích chuột vào một trong 3 

ô trống để lựa chọn kiểu file 

tuỳ theo mục đích tìm kiếm 

2. Gõ tên file hoặc một phần 

tên file cần tìm kiếm vào đây. 

3. Kích vào Search để bắt đầu 

tìm kiếm. 

1. Kích chuột vào một 

trong các tuỳ chọn nếu bạn 

nhớ về thời gian lần cuối 

bạn mở file đó 

2. Gõ tên file hoặc một 

phần tên file 

3. Kích vào Search để bắt 

đầu tìm kiếm. 
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Hình 3.35 

 

+ Nếu bạn kích chuột vào mục All files and folders, sẽ cho phép bạn tìm kiếm 

bất kỳ kiểu tệp và thư mục nào. Thực hiện tìm kiếm theo các bước như hình 3.36. 

 

 

1. Kích chuột vào một 

trong các tuỳ chọn nếu bạn 

nhớ về thời gian lần cuối 

bạn mở file đó 

2. Gõ tên file hoặc một 

phần tên file 

3. Kích vào Search để bắt 

đầu tìm kiếm. 
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1. Gõ tên hoặc một phần tên file 

hoặc thư mục cần tìm kiếm. 

2. Gõ cụm từ xuất hiện trong file cần 

tìm kiếm (có thể bỏ qua bước này). 

3. Kích vào mũi tên để chọn ổ đĩa 

mà bạn nghi ngờ file cần tìm nằm 

trong đó. 

5. Kích Search để bắt đầu tìm kiếm. 

4. Kích vào các mũi tên để khai bao 

thêm nếu bạn có các thông tin về 

ngày tháng tạo, kích cỡ file 
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Hình 3.36 

 

+ Kích chuột vào mục Computer or People, cho phép tìm tên máy tính kết nối 

nếu nối mạng và tên người nếu sử dụng danh bạ địa chỉ trong Outlook, phần này ít 

dùng. 

 

 

Bài 3.10: Sử dụng Windows Explore 

Các chương trình và dữ liệu của bạn được lưu thành các tập tin (Files) trên các 

thiết bị như: Ổ đĩa cứng; đĩa mềm; đĩa Zip; đĩa CD ghi được (Rewriteable); ổ đĩa 

mạng...Chúng ta cũng đã biết cách mở các ổ đĩa và xem nội dung thông tin bên 

trong các ổ đĩa trong các bài học trước. Windows cung cấp một công cụ cho phép 

xem và quản lý thư mục và tệp một cách chuyên nghiệp và hệ thống, đó là 

Windows Explore.  

1. Gõ tên hoặc một phần tên file 

hoặc thư mục cần tìm kiếm. 

2. Gõ cụm từ xuất hiện trong file cần 

tìm kiếm (có thể bỏ qua bước này). 

3. Kích vào mũi tên để chọn ổ đĩa 

mà bạn nghi ngờ file cần tìm nằm 

trong đó. 

5. Kích Search để bắt đầu tìm kiếm. 

4. Kích vào các mũi tên để khai bao 

thêm nếu bạn có các thông tin về 

ngày tháng tạo, kích cỡ file 



Giáo trình Sử dụng hệ điều hành và quản lý máy tính 

 

62 

 

Để mở Windows Explore ta thực hiện như sau: 

- Kích phải chuột trên nút Start và chọn mục Explore để mở Windows 

Explore.  

- Cửa sổ Windows Explore xuất hiện như trên hình 3.37 bao gồm: 

  +  Khung trái chứa tên các ổ đĩa và các thư mục theo dạng hình cây. Thư mục 

ở cấp cao hơn có dấu (+) bao các thư mục ở cấp nhỏ hơn. Thư mục ở mức thấp nhất 

có dấu (-). Khi kích chuột vào dấu (+), bạn sẽ xem được các thư mục con bên trong. 

Nếu kích chuột vào dấu (-), bạn sẽ thu gọn nhánh phân cấp thư mục con. 

+ Khung phải hiển thị nội dung của mục được chọn trên khung trái. Muốn mở 

tệp hoặc thư mục nào bên khung phải, bạn chỉ việc kích đúp chuột vào tệp và thư 

mục đó.  

 
Hình 3.37 
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BÀI TẬP CHƯƠNG 3 

1. Mở My Computer 

2. Xem nội dung ổ đĩa C 

3. Tạo một thư mục đặt tên cá nhân của bạn trong ổ đĩa C 

4. Nhét đĩa mềm vào máy tính và copy thư mục vừa tạo ở ổ C vào ổ đĩa A 

5. Xoá thư mục vừa tạo trong ổ đĩa C 

6. Mở thùng rác và khôi phục lại thư mục vừa xoá.  

7. Mở Windows Explore và xem nội dung ổ đĩa A 

8. Tại cửa sổ Windows Explore, xem nội dung ổ C dưới chế độ hiển thị theo 

danh sách liệt kê (list). 

9. Ở chế độ hiển thị List của câu 8, bạn hãy sắp xếp các tệp và thư mục theo thứ 

tự abc. 

10. Sử dụng công cụ tìm kiếm Search, bạn hãy tìm tệp có tên “readme.txt” 

trong ổ đĩa C. Sau khi tìm được tệp đó, bạn mở ra xem nội dung tệp. 
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Menu 

Start 

Chương  

trình khởi 

động 

nhanh 

chứa biểu tượng 

các chương 

trình khởi động 

cùng hệ thống 

Menu 

Start 

Chương  

trình khởi 

động 

nhanh 

chứa biểu tượng 

các chương 

trình khởi động 

cùng hệ thống 

 

Chương 4 

QUẢN LÝ THANH TÁC VỤ TASKBAR VÀ MÀN HÌNH 

DESKTOP 

 

Khi bạn bật máy tính và Windows khởi động xong, điều đầu tiên bạn nhìn thấy 

trên màn hình máy tính chính là thanh tác vụ Taskbar và màn hình Desktop. Đây là 

hai thành phần quan trọng của hệ điều hành máy tính. Thanh tác vụ taskbar là trung 

tâm điều khiển của Windows, nơi bạn bắt đầu và quản lý tất cả các chương trình 

trong máy tính. Màn hình Desktop là không gian làm việc, nơi mọi công việc diễn 

ra trên nền màn hình Desktop. 

Với ý nghĩa quan trọng của chúng, trong chương này ta sẽ nắm được các kỹ 

năng quản lý thanh taskbar và màn hình Desktop nhằm phục vụ công việc một cách 

tốt nhất. 

 

 

Bài 4.1: Thiết lập các tùy chọn cho thanh Taskbar 

Thanh taskbar bao gồm các thành phần như hình vẽ dưới đây 

 

 

 

   

 

Hình 4.1 

 

1. Thiết lập các tùy biến cho thanh Taskbar 

- Kích phải chuột vào thanh Taskbar và chọn Properties. Cửa sổ Taskbar 

and Start Menu Properties sẽ xuất hiện như hình 4.2. 

Chứa các chương trình đang kích hoạt 

Chứa các chương trình đang kích hoạt 
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Hình 4.2 

- Kích chuột vào thẻ Taskbar, cho phép thiết lập các tùy biến với thanh taskbar: 

Kích 

chuột 

vào thẻ 

Taskbar 

Kích 

chuột 

vào thẻ 

Taskbar 
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 + Phần Taskbar Appearance: cho phép quản lý giao diện thanh Taskbar. Bạn 

kích chuột vào ô trống của các tính năng dưới đây, tính năng đó sẽ được kích hoạt 

 . Lock the Taskbar: khóa thanh Taskbar. Cố định thanh Taskbar, không cho 

phép người dùng thay đổi vị trí và kích thước thanh Taskbar. 

. Auto-hide the taskbar: tự động ẩn thanh Taskbar khi không dùng đến nó. Khi 

bạn đặt chuột vào vị trí thanh taskbar, nó sẽ tự động hiện lên. 

. Keep the taskbar on top of other Windows: thanh Taskbar luôn xuất hiện khi 

mở bất kỳ cửa sổ Windows nào. Nếu tắt tính năng này, khi bạn mở một cửa sổ 

chương trình Windows, chúng sẽ che phủ lên thanh taskbar, gây khó khăn cho việc 

sử dụng thanh taskbar chuyển đổi giữa các chương trình. 

. Group Similar taskbar buttons: chức năng này cho phép nhóm các cửa sổ 

thuộc cùng một chương trình vào thành một nhóm, dễ dàng cho việc sử dụng và 

chuyển đổi giữa các chương trình. 

. Show quick launch: hiển thị trên thanh taskbar phần chứa các chương trình 

khởi động nhanh. 

 + Phần Notification Area: cho phép thiết lập các tuỳ biến với vùng chứa biểu 

tượng các chương trình khởi động cùng hệ thống trên thanh taskbar.  

    . Show the clock: cho phép hiển thị đồng hồ hệ thống. 

    . Hide inactive icons: cho phép ẩn đi biểu tượng các chương trình không 

kích hoạt 

2. Quản lý thanh Taskbar 

- Di chuyển thanh Taskbar: 

 + Bạn phải chắn chắc thanh Taskbar không bị khóa (bỏ dấu tích khỏi tính năng 

Lock the Taskbar) 

 + Đặt chuột vào thanh Taskbar, giữ và kéo đến vị trí nằm dọc bên trái hoặc bên 

phải màn hình, hoặc bên trên màn hình. 
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Hình 4.3 

- Thay đổi kích thước thanh taskbar 

+ Bạn phải chắn chắc thanh Taskbar không bị khoá (bỏ dấu tích khỏi tính năng 

Lock the Taskbar) 

+ Đặt chuột vào vị trí biên trên của thanh taskbar sao cho con chuột biến thành 

hình  (Hình  4.4). Giữ và kéo chuột để có kích thước theo ý muốn. 

 
Hình 4.4 

 

3. Thiết lập các tuỳ biến cho menu Start 
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- Đặt chuột lên thanh taskbar, kích phải chuột và chọn Properties. Cửa sổ 

Taskbar and Start Menu Properties xuất hiện.  

- Kích chuột vào thẻ Start menu, cho phép bạn thiết lập các tùy biến với menu 

Start.  

 

 

Hình 4.5 

Bạn có thể tùy chọn chế độ hiển thị cho menu Start, Windows XP cung cấp hai 

chế độ hiển thị: 

Kích chuột 

vào Start 

Menu 

Kích chuột 

vào Start 

Menu 
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+ Nếu chọn Start menu: menu Start sẽ hiển thị với giao diện mới của 

Windows XP, cho phép bạn truy nhập nhanh vào tài liệu, tệp ảnh, âm thanh và các 

chương trình thường dùng. Với những ai đã sử dụng quen giao diện của menu Start 

trong các hệ Windows trước như Windows 98, Windows 2000 sẽ chưa quen với chế 

độ hiển thị này. 

+ Nếu chọn Classic Start Menu: menu Start sẽ hiển thị với giao diện cũ, đã 

quen thuộc với người dùng Windows 98 hoặc Windows 2000.     

 

Bài 4.2: Làm việc với thanh Quick Launch trên Taskbar 

Như ta đã biết trên thanh taskbar có chứa thanh Quick Launch. Trên thanh 

Quick Launch chứa biểu tượng các chương trình cho phép khởi động nhanh. Tất cả 

các chương trình khởi động trên máy tính đều có thể đưa vào thanh Quick Launch. 

Nhưng thông thường ta hay đưa vào thanh Quick Launch các chương trình thường 

xuyên sử dụng. Để thực hiện việc này, ta làm như sau: 

Nếu thanh Quick Launch chưa xuất hiện trên thanh Taskbar thì để hiển thị trên 

Taskbar, bạn phải đánh dấu vào tính năng Show Quick Launch trong phần thiết lập 

tùy chọn cho Taskbar. 

- Đặt chuột lên một vị trí trống của thanh Quick Launch 

- Kích phải chuột và chọn Open Folder 

- Cửa sổ chương trình Quick Launch xuất hiện như hình 4.6, đây là thư mục 

chứa tất cả các biểu tượng chương trình hiển thị trên thanh Quick Launch: 

 
Hình 4.6 
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Muốn thêm chương trình nào, bạn chỉ cần copy biểu tượng khởi động của 

chương trình đó vào thư mục Quick Launch này. Ngược lại muốn xoá chương trình 

nào, bạn chỉ cần xóa biểu tượng chương trình đó khỏi thư mục Quick Launch. 

Sau khi thao tác xong, bạn đóng thư mục Quick Launch và thấy trên thanh 

Quick Launch sẽ chứa biểu tượng các chương trình mà bạn đã thay đổi. Muốn khởi 

động nhanh chương trình nào, bạn chỉ cần kích chuột vào chương trình đó trên 

thanh Quick Launch. 

 

Bài 3: Tạo Shortcut trên màn hình Desktop 

Như ta đã biết, menu Start chứa toàn bộ các chương trình có trên máy tính. 

Muốn khởi động các chương trình này, bạn phải vào menu Start. Với các chương 

trình thường xuyên sử dụng, nếu phải vào menu Start để khởi động sẽ mất thời 

gian. Windows cho phép bạn tạo các shortcut của các chương trình cần khởi động 

trên màn hình Desktop. Khi đó, bạn chỉ cần kích đúp chuột vào shortcut là có thể 

khởi động được chương trình đó. Thực chất, shortcut chỉ là đường link để trỏ tới tệp 

gốc, thư mục gốc hoặc biểu tượng khởi động gốc của chương trình cần mở. Do vậy, 

bạn dễ dàng tạo, di chuyển và xóa các shortcut mà không ảnh hưởng đến chương 

trình gốc. 

Để tạo một shortcut trên desktop, bạn thực hiện như sau: 

- Mở thư mục chứa tệp gốc, thư mục gốc hoặc biểu tượng chương trình gốc. 

 - Kích chuột vào tệp gốc, thư mục gốc hoặc biểu tượng chương trình gốc cần 

tạo shortcut trên màn hình Desktop. 

- Kích phải chuột và chọn Send to → Desktop. Khi đó, Windows sẽ tự tạo ra 

một shortcut cho chương trình vừa chọn trên màn hình Desktop.  

 

Bài 4.4: Thiết lập các chương trình khởi động cùng hệ điều hành Windows 

Trong quá trình sử dụng máy tính, có những chương trình bạn thường xuyên sử 

dụng khi bật máy tính, ví dụ như bộ gõ Vietkey hay chương trình quét virus...Để tiết 

kiệm thời gian khởi động chúng mỗi khi bật máy, Windows cho phép bạn thiết lập 

các chương trình khởi động cùng Windows trong chương trình Startup. Tất nhiên, 

bạn cũng không lên lợi dụng chức năng này quá, chỉ với những chương trình cần 
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thiết phải sử dụng ngay khi làm việc với máy tính mới lên đưa vào Startup. Bởi nếu 

có quá nhiều chương trình trong Startup sẽ làm cho việc khởi động xong Windows 

mất thời gian nhiều hơn. 

Để thiết lập các chương trình vào trong Startup, bạn thực hiện như sau: 

- Kích phải chuột vào menu Start, chọn Open 

- Kích đúp chuột vào thư mục Program 

- Kích đúp chuột vào thư mục Startup 

Muốn khởi động chương trình nào cùng hệ điều hành Windows, bạn chỉ cần 

copy và dán vào thư mục Startup biểu tượng khởi động của chương trình. Tương 

tự, bạn cũng có thể xóa các chương trình khởi động cùng Windows trong thư mục 

Startup. 

Lưu ý: Tất cả các biểu tượng khởi động của các chương trình được cài đặt trong 

máy tính đều nằm trong các thư mục của chương trình đó theo đường dẫn 

C:\Program Files hoặc D:\Program Files, tùy theo hệ điều hành Windows được cài 

đặt vào ổ đĩa nào. 
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BÀI TẬP CHƯƠNG 4 

 

1. Di chuyển thanh Taskbar sang bên trái màn hình Desktop. Sau đó đưa xuống 

dưới màn hình Desktop. 

2. Hiển thị cửa sổ Properties của thanh Taskbar và xem các tính năng thiết lập. 

3. Tạo shortcut chương trình NotePad trên màn hình Desktop.  

4. Đưa chương trình khởi động Vietkey vào thư mục Startup.  




